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Tips for reading this e-book
Your e-book Reader has many options for viewing and navigating
through an e-book. Explore the dropdown menus and toolbar at
the top and the status bar at the bottom of the display window to
familiarize yourself with these.
The following guidelines are provided to assist users who are not
familiar with PDF files. For a complete user guide, see the Help menu
of your Reader.
• You can read the pages in this e-book one at a time, or as two
pages facing each other, as in a regular book. To select how you’d
like to view the pages, click on the View menu on the top panel
and choose the Single Page, Continuous, Facing or Continuous
– Facing option.
• You can scroll through the pages or use the arrows at the top
or bottom of the display window to turn pages. You can also
type a page number into the status bar at the bottom and be
taken directly there. Or else use the arrows or the PageUp and
PageDown keys on your keyboard.
• You can view thumbnail images of all the pages by clicking on the
Thumbnail tab on the left. Clicking on the thumbnail of a particular
page will take you there.
• You can use the Zoom In and Zoom Out tools (magnifying glass)
to magnify or reduce the print size: click on the tool, then enclose
what you want to magnify or reduce in a rectangle. To move
around the page use the Hand tool.
• To reset the page display size, click on one of the icons that looks
like a paper sheet and try different page display sizes. This option
is also available from the View menu.
• To search for a word in the document, click on the Find tool
(binoculars) and type in the word you are looking for.
• Some versions of e-book Readers, might allow you to bookmark,
highlight and underline text in your e-book and add notes or comments. Check the menu bar and tool icons to see if these options
are available in your reader.
For more tips, check out Adobe’s frequently asked questions for
e-book users by clicking here.
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INT R ODU C T ION

Introduction to

Prague
Most people come to Prague
because they’ve heard it’s a
beautiful place, and they’re
rarely disappointed. With
some six hundred years
of architecture virtually
untouched by natural disaster or war, few other European capitals look as good.
The city retains much of its
medieval layout and its rich
mantle of Baroque, Rococo
and Art Nouveau buildings
have successfully escaped the vanities and excesses of
postwar redevelopment.
Physically, Prague may have
weathered the twentieth century
very well but it suffered in other
ways. The city that produced the
music of Dvorák and Smetana,
the literature of Capek and Kafka
and modernist architecture to
rival Bauhaus, was forced to
endure a brutal Nazi occupation.
Then for forty years, during the
Communist period, the city lay
hidden behind the Iron Curtain,
seldom visited by Westerners. All
that changed in the 1990s and

When to visit
Prague is now so popular that the streets around the main sights are
jam-packed with tourists for much of the year. If you can, it’s best to avoid
the peak months of July and August, when temperatures soar above 30ºC,
and you have to fight your way across the Charles Bridge. The best times
to visit, in terms of weather, are May and September. The winter months
can be very chilly in Prague, but if you don’t mind the cold, the city does
look good in the snow. Christmas and New Year are perfect: there are
Christmas markets right across town, and plenty of mulled wine and hot
punch to keep you warm.
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Cathedral door

왔

Malá Strana, Charles Bridge and Staré Mesto
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INT RODU C T IO N

nowadays, Prague is
one of the most popular European city break
destinations, with a
highly developed tourist industry and a large
expat population who,
if nothing else, help to
boost the city’s nightlife.
The River Vltava
winds its way through
the heart of Prague,
providing the city
with its most enduring
landmark, the Charles
Bridge. Built during the city’s medieval
golden age, this stone
bridge, with its parade
of Baroque statuary,
still forms the chief
link between the old
town and Prague’s hilltop castle. The city is
surprisingly compact, making it a great place to explore on foot,
and despite the twisting matrix of streets, it’s easy enough to find

왔
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Malostranské námestí

your way around between the major landmarks. If you do use public
transport, you’ll find a picturesque tram network and a futuristic
Soviet-built metro system that rivals most German cities. And, for the
moment at least, it’s still a relatively cheap destination, with food and
perhaps, most famously beer, costing way below the EU average.
왖

Prague Castle by night
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Prague
AT A GLANCE
INT RODU C T IO N

PRAGUE CASTLE
The city’s left bank is dominated
by Prague Castle or Hrad, which
contains the city’s cathedral, the

old royal palace and gardens,
and a host of museums and
galleries.

MALÁ STRANA

왖

Squeezed between Prague Castle
and the river is the picturesque
district of Malá Strana, with its
twisting cobbled streets, Baroque
palaces and secret walled
gardens.

Changing of the Guard, Prague Castle

ˇ
STARÉ MESTO
The medieval hub of the city, Staré
Mesto – literally, the “Old Town”
– is probably the most visited part
of the city, and has a huge
number of pubs, bars and restaurants packed into its labyrinthine
layout.

왖

Staromestke, Námestí and Staré Mesto
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ˇ
NOVÉ MESTO

INT R ODU C T ION

Nové Mesto, the city’s commercial
and business centre, is a large
sprawling district that fans out
from Wenceslas Square (Václavské
námestí), focus of the political
upheavals of the modern-day
republic.

ˇ
VYSEHRAD,
VINOHRADY
ˇ ˇ
AND ZIZKOV

왖

The fortress of Vysehrad was one
of the earliest points of settlement
in Prague, whereas Vinohrady &
Zizkov are rather grand latenineteenth suburbs.

Nerudoava, Malá Strana

JOSEFOV
왖

National Theatre

Enclosed within the boundaries of
Staré Mesto is the former
Jewish quarter, Josefov. The ghetto walls have long since gone and
the whole area was remodelled at
the end of the nineteenth century,
but six synagogues, a medieval
cemetery and a town hall survive
as powerful reminders of a community that has existed here for
over a millennium.

ˇ
HOLESOVICE
Another late nineteenth-century
development, Holesovice is home

왖

Old Jewish cemetery, Josefov
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왖
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Turn-of-the-century mansions, Vinohrady

to Prague’s impressive museum of
modern art, the Veletrzní Palace,
and Vystaviste, its old-fashioned
trade fair grounds.

ˇ
HRADCANY
The district immediately outside
the castle gates is a wonderfully
quiet quarter filled with old palaces
housing government ministries and
embassies.
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Vystaviste, Holesovice

More of a wide boulevard than a
square, it was here that Czechs
gathered in their thousands during
the 1989 Velvet Revolution.

왖

WENCESLAS SQUARE
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You can have
a great time
in Prague just
wandering the
streets, wondering
at the architecture,
but there are six
big sights you
should definitely
make the effort
to see, no matter how
short your visit. Few
people miss Prague’s
medieval Charles Bridge
and the picturesque
Old Town Square, but
it’s also worth exploring

 Wenceslas Square

Prague Castle, home to

The modern hub of Prague, this sloping
boulevard was the scene of the 1989 Velvet
Revolution.

the city’s cathedral, old
royal palace and gardens;
Josefov, Prague’s former

P.98  WENCESLAS SQUARE AND
NORTHERN NOVÉ MESTO

Jewish ghetto; the Art
Nouveau Obecní dum;
and Wenceslas Square,
where the 1989 Velvet
Revolution took place.

 Obecní dum
Café, bar, restaurant, exhibition space and
concert hall, this Art Nouveau masterpiece is
preserved exactly as built in 1911.
P.101  WENCESLAS SQUARE AND
NORTHERN NOVÉ MESTO
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 Old Town
Square
The city’s showpiece
square, lined with exquisite
Baroque facades and overlooked by the town hall’s
famous astronomical clock.
P.80  STARÉ
MESTO

 Charles Bridge
Decorated with extravagant ecclesiastical
statues, this medieval stone bridge is the
city’s most enduring monument.
P.75  STARÉ MESTO

 Prague Castle

 Josefov

Towering over the city, the castle is the ultimate picture-postcard image of Prague.

The former Jewish ghetto contains no fewer
than six synagogues, a town hall and a
remarkable medieval cemetery.

P.51  PRAGUE CASTLE

P.91  JOSEFOV
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The food and drink
may be cheap,
but Prague is no
budget destination
when it comes to
hotels. However,
with so many ancient
buildings to choose from,
and more competition
than ever among hoteliers,
the city now has a good
selection of places to stay,
many of which have real
character.

 U cerveného lva
A classic Prague hotel with original
seventeenth-century wooden ceilings and
tasteful antique furnishings, including rugs
over parquet flooring.
P.136  MALÁ STRANA

 Cerny slon
A hotel offering simple rooms tucked away
down an alleyway off the Old Town Square
itself.
P.137  STARÉ MESTO

Contents

Ideas

15
 Hotel Imperial
Plain, cheap, hostel-style rooms set in an
otherwise extremely ornate 1914 Art
Nouveau masterpiece.
P.139  NOVÉ MESTO

 Dum U velké boty
For attentive service and stylish antique
décor, head for this discreet bolthole in the
backstreets of Malá Strana.
P.136  MALÁ STRANA

 U medvídku
If you’re looking for unpretentious, inexpensive and
centrally located rooms,
try one of Prague’s most
authentic pubs.
P.137  MALÁ
STRANA

 Cloister Inn
A former nunnery hidden
in the backstreets of Staré
Mesto.
P.137  STARÉ MESTO
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Prague doesn’t

 Royal Gardens

have a vast

Castle gardens famous for their disciplined
crops of tulips.

number of parks,

P.57  PRAGUE CASTLE

but it does have
a whole host of
wonderful hidden
Baroque gardens
in Malá Strana,
several of which
are linked via
terraces to the
gardens around

the castle. The largest
green space in the centre
is the Petrín hill, accessible
via a funicular railway, and
boasting great views over
the city. Further afield,
Vysehrad’s fortress and
the woods of Stromovka
are good places to lose
the crowds in summer.
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 Petrín
This wooded hill on Prague’s left bank provides a spectacular viewpoint over the city.
P.71  MALÁ STRANA
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 Stromovka
Large leafy park laid out between Vystaviste
and the chateau of Troja.
P.128  HOLESOVICE

 Kampa
The chief park on the island of Kampa
enjoys fine views across to Staré Mesto.
P.69  MALÁ STRANA

 Malá Strana
terraced gardens
Pretty little Baroque gardens laid out on the
terraced slopes below the castle.
P.68  MALÁ STRANA

 Vysehrad
This old Habsburg military fortress is now a
great escape from the busy city.
P.115  VYSEHRAD, VINOHRADY
AND ZIZKOV
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The full force

 Cathedral of sv Vít

of the Counter-

The Tomb of St John of Nepomuk in the
city’s cathedral is the most spectacular
reminder of the former power of the Jesuits.

Reformation was
brought to bear

P.53  PRAGUE CASTLE

on the Czechs,
who took to
Protestantism
en masse in the
Renaissance.
The legacy of this
ideological battle
can be seen in the
city’s enormous
wealth of Baroque

art and architecture:
great Italianate domes
dominate the skyline and
melodramatic statuary
peppers the streets – most
famously, the Charles
Bridge.

 Old Town Square
Probably the most impressive parade of
Baroque facades and gables in all Prague.
P.80  STARÉ MESTO
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